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Great Way to Start Out 2020  
Attend the Winter State Meeting | Tuesday January 14, 2020  

Radisson, 2200 Freeway Blvd, Minneapolis, Minnesota 
 

This Meeting is for All Members from All Chapters 

8:30  Registration 
 

9:00  Pick one of the following sessions: 
   1. Vaping in School ~ What should schools do to protect children. 
   2. Building & Grounds Best Practices 
     

10:00  Break 
 

10:15  Pick one of the following sessions: 
   1. IAQ ~ There are a variety of IAQ requirements for Minnesota schools.   
   2. School Construction Projects: What to do when things go  
    wrong (and how to protect  against problems).   

11:15  Lunch & Business Meeting 
 

Noon Keynote:  Beyond Grit, Cindra Kamphoff 
   Overcome the Odds | Live with Purpose | Reach Your Ultimate Best 

MASMS Boot Camp | Offered in July 2020 
  

Dates & time:  Wednesday July 22nd  and Thursday July 23rd, 2020, 8:00 AM 
to 4:00 PM, dinner at 6:00 PM on Wednesday evening 
 

Location:   Holiday Inn, St. Cloud, MN 
 

Cost:  MASMS will cover the cost of this training, including hotel & meals. 
 

Boot Camp Information: The MASMS Boot Camp is specifically designed 
to provide training for facility professionals.  
 

The following topics will be covered:  
Custodial | Grounds | Maintenance Management | Security | Health & Safety 
| Transportation Standards | Best Practices | Training  | Equipment | Man-
agement Tools | Inspections | Budgets | Staff Management &  Development 
 

Instructors  This course is taught by seasoned experienced facility staff 
from public schools.  Mike Boland (ISD #622), Scott Hogen (Mankato 
Schools), Chis Pint (ISD#196) and Laura Masley (Elk River Schools), who 
have over 75 years of combined experience! 
 

Contact the MASMS Office to Register | ruth @ masms.org | 320-685-4585 
Please indicate if you need a hotel reservation, and if so for one or two nights.  

Happy New Year! Make the Most of Each and Every One of the 527,040 Minutes of 2020! 
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Education…  
Key to All of Our Futures! 
 
Hopefully you all had a great holiday season, and that everyone is surviving our early winter! 
Old Man Winter must have stubbed his toe…or something else must have got him all wound 
up! 
 
I would like, once again, encourage everyone to take advantage of the awesome educational 
opportunities MASMS offers. Our jobs are evolving so rapidly that without ongoing educa-
tion, I am not sure how anyone would be able to keep pace!  There is not a better time to 
brush up on your skillset than right now. 
Over the next several years, we will have a lot of Directors, Supervisors & Coordinators retir-
ing…including the old-guy writing this column!  Do you have the skills, training & certifica-
tions needed to step into one of these wonderful jobs? MASMS is here to help pave the way!   
 
 

Here is a list of just a few of your educational opportunities! 
January 14, 2020 ~ MASMS Winter State Meeting (Held in Minneapolis) 
January 15, 2020 ~ West Chapter Meeting 
January 16, 2020 ~ Northern Chapter Meeting 
February 11, 2020 ~ Metro Chapter Meeting 
February 19, 2020 ~ Southern Chapter Meeting 
Chapter meetings are held every 4-6 weeks, please see our MASMS website for a complete listing:  
https://www.masms.org/page/2524 
 
In addition to chapter meetings, every June, we put on Custodial, Maintenance & Grounds APPRECIATION DAYS in each 
chapter’s area. This is a chance for you & your staff to get away from the day to day grind and meet your counterparts 
from districts around the state. In addition to meeting & networking, there are tons of hour-long educational sessions on 
everything from boilers, grounds care, fire safety, custodial equipment care, HVAC & OSHA to name just a few. The day 
includes coffee & rolls, lunch, many chances to win some really nice prizes, and of course educational opportunities ga-
lore as mentioned above. Everyone feels better when they can make repairs or do things without having to ask for help, 
so please encourage your staff to attend. Those who have in past years love it!  Schedule time away from the daily grind 
now so that you don’t miss this annual educational gem!  
 
Lastly, improve your skill and qualifications even further by enrolling in our MASMS Facility Management Certification 
Program!  For more information regarding this prestigious certification, please click here: https://www.masms.org/
sites/masms.portal.rschooltoday.com/files//certification_flyer_2012_two.pdf 
 
In closing, MASMS is always looking for more and better ways to meet the needs of its members. Please let any board 
member know what we might consider adding, or improving so that we can continue to fill the “MASMS Toolbox” to 
help you become the best leader, or Future Leader possible! 
 
Best wishes, and I hope to see you at our State Educational Meeting on January 14th! 
Kevin 

Kevin Johnson,  
Southern Chapter Director 

“One way to get 
the most out of life 
is to look upon it as 

an adventure.”  

Another reason to make time for yourself and your staff to attend 

MASMS educational events and meetings: 
 

74% of employees believe ongoing training would help them trust 

their employer more, and a high-trust work environment  

helps employees perform at their best! 

https://www.masms.org/page/2524
https://www.masms.org/sites/masms.portal.rschooltoday.com/files/certification_flyer_2012_two.pdf
https://www.masms.org/sites/masms.portal.rschooltoday.com/files/certification_flyer_2012_two.pdf
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Health & Safety  The MASMS Health & Safety Committee supplies information for this 

section.  If you have a specific topic you would like to see covered, let the MASMS office know. 
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        Tips for  
        Starting a Safety  

        Committee 
Know where to start. 
The first place to start is have management commitment. Management needs to be able to dedicate resources to 
the committee. Resources may not include financial support; it could be the ability to ensure an employee is able 
to step away from their work to go to the meetings.  
 
Another good place to start is to check state and local rules regarding safety committees. Minnesota Statute 
182.676 requires all employers of more than 25 employees to establish a safety committee and every employer 
of 25 or less if: 

The employer has a lost workday case incidence rate in the top 10% of all rates for employers in the same 
industry. 

Worker’s compensation premium classification assigned to the greatest portion of the payroll for the em-
ployer has pure premium rate as reported by the Workers’ Compensation Rating Association in the top 
25% of premium rates for all classes. 

 

State your purpose. 
When building the committee document bylaws, responsibilities, procedures, and goals. The bylaws can include 

specific activities that will happen monthly, quarterly, or 
annually, and the person(s) responsible.  
 

Get organized. 
Lay down the groundwork and the expectations for the 
members. Know how the minutes will be recaptured and 
distributed. If there is no written documentation, it never 
happened.  
Determine the length a member will serve on the commit-
tee. A steady stream of new ideas is ideal for a safety com-
mittee.  
 

Choose members wisely. 
Have an equal representation of workers and management. 
There should be participation from different departments, 
shifts or trades. 
 

Plan ahead. 
Determine the purpose(s) of each meeting. Decide which 
members could share knowledge about the meeting subject 
or if an expert should be invited to speak on the matter.  
Following an agenda will keep the meeting flowing and 
ensure tasks are completed. Keep time for employees to 
discuss specifics.  
 

Stress accountability.  
Safety committees benefit from having different voices in 
an organization present on topics. This creates an engaged 
safety committee. And an engaged safety committee will 
improve working conditions, safe work practices and safe-
ty programs.  
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Looking for a Mentor?  Options Include: 

• Meet once a month with your MASMS Mentor  

• Phone contact only—Contact only when issues arise or 

when you need advice. 

Contact  the MASMS office at  ruth@masms.org if you would 

like to find a mentor! 

 

NEW EDUCTIONAL  
MEMBERS 

Lowell Fabian 
St. Charles Schools 
 

NEW BUSINESS MEMBERS 
Zack Lasken 

Fire Protection Equipment Company 
 

Joe Holman, Insight Restoration 
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“And then I  
realized  

adventures are  
the best way  

to learn.”  
-Unknown  

Employee Morale | Start out 2020 With 
Some Fun at Work 

 
No one is going to address employee  
morale for you. Remember to communicate 
regularly and provide just enough challenge 
to encourage growth without stressing out 
your team. When employees feel  
encouraged to do their best work, they can 
do so with confidence. 
 
Tell a joke or two, and even schedule some 
casual one-on-ones to get to know your staff 
on a more personal level. All of these 
moves let your employees know that you’re 

a human being, 
not just a boss — 
and that you see 
them as more 
than just  
employees. 
 
Have some fun! 

http://blog.15five.com/flipping-org-chart-supporting-employee-success/
http://blog.15five.com/flipping-org-chart-supporting-employee-success/
http://blog.15five.com/flipping-org-chart-supporting-employee-success/
http://blog.15five.com/flipping-org-chart-supporting-employee-success/
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Vaping Detectors  

Allowable School District or Charter School Cost under  

Long-Term Facilities Maintenance Revenue? 
 

Long-Term Facilities Maintenance (LTFM) revenue is not allowable for vaping detector 

or sensor device purchases.  Vaping detectors are considered an alert system which may 

include multiple detection sensors to detect vapor, smoke, sounds (decibel level analysis), 

Tetrahydrocannabinol (THC) oils, and other related measurements.  Sound detection mon-

itors anomalies that could indicate fighting, bullying, or even shots fired.  These systems 

utilize software technology for school climate improvement (MDE School Climate 

webpage) and school safety solutions.  Some detectors have the capability of connecting 

to facility security cameras with computer program monitoring. 

All these system characteristics relate to 1) Safe Schools revenue which is different than 2) Health and Safety Capital 

Projects revenue (Minn. Stat. § 123B.57).  Each revenue authority is governed by separate Minnesota Statutes and 

each statute lists distinct, allowable expenditures for separate purposes.  The Safe Schools Levy proceeds may be 

used to pay for costs such as crime prevention, drug abuse, student and staff safety and violence prevention measures 

taken by the school district (Minn. Stat. § 126C.44, section (a)(5)).  A similar statutory reference in the Health and 

Safety Capital Projects statute is “fire and life safety”.  This should not be confused with “student and staff safety”.  

Fire and life safety is a fire code requirement and does not apply to vape detectors.  According to the Minnesota State 

Fire Marshal office, there is currently nothing in future fire code regulations that would require vape detector pur-

chases since it is not related to “fire and life safety”.   

 

For Fiscal Year (FY) 2020, there are two safe schools revenue options: 

1) Safe Schools Levy and 2) Safe School Supplemental Aid:  

Safe Schools Levy (ongoing, levy authority FY 2020 and beyond) – Minnesota Statute, section 126C.44.  Only 

school districts, not charter schools, have levy authority under this category.  Currently, the maximum allowable lev-

ied amount is equal to $36 multiplied by the district’s adjusted pupil units (APU) for the school year.  Levy proceeds 

must be reserved and used for funding authorized purposes.  Many schools currently budget the majority of these 

levied dollars each year for allowable School Resource Officer (SRO) expenditures.    

   

FY 2020 Safe School Supplemental Aid (new in FY 2020, aid authority FY 2020 only) – Schools have been allo-

cated a one-time safe schools supplemental $30 million as outlined in the Superintendent’s Mail dated 10-03-19.  

Both school districts and charter schools must reserve these dollars and use for only purposes authorized in Minneso-

ta Statutes, section 126C.44.  Please reference the mail-

ing for other safe schools supplemental aid require-

ments. You may find the one-time allocated safe 

schools supplemental aid per school on the MDE web-

site under the Fiscal Year 2020 Safe Schools Supple-

mental Aid.  This information is posted on the Funding 

Projections and Trends webpage which displays MDE 

information to include spreadsheets based on the cur-

rent legislative sessions and forecasts.  

 

For questions about other allowable LTFM project ex-

penditures, please contact Sarah C. Miller at Sa-

rah.C.Miller@state.mn.us or 651-582-8370. 

 

https://education.mn.gov/MDE/dse/safe/clim/index.htm
https://www.revisor.mn.gov/statutes/cite/123B.57
https://www.revisor.mn.gov/statutes/cite/126C.44
https://education.mn.gov/MDE/dse/supt/mail/
https://education.mn.gov/MDE/dse/schfin/trend/
https://education.mn.gov/MDE/dse/schfin/trend/
https://education.mn.gov/MDE/dse/schfin/trend/
https://education.mn.gov/MDE/dse/schfin/trend/
mailto:Sarah.C.Miller@state.mn.us
mailto:Sarah.C.Miller@state.mn.us
mailto:Sarah.C.Miller@state.mn.us
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Only One New Year’s Resolution This Year 
 
Like most of us, over the years I have had many typical New Year’s resolutions such as eat-
ing better, losing weight, exercise more, etc. This year I have decided to only have one  
resolution but it’s an important one and I hope to do better with sticking with this resolution 
longer than I usually do with others in the past. To put it very simply:  I am resolving to  
appreciate my life more. 
 
It is way too easy to take things for granted, too easy to get upset at the smallest and most 
inconsequential of things many days. It’s too easy to lose sight of just how fortunate most of 
us are, what wonderful families and friends we have, being in good health, and life’s many 
other blessings. 
 
I lost my 87 year old father in 2019, and right now a close friend and colleague of mine is 

battling for his life after being diagnosed only four months ago with cancer. Situations like these are “wake-up calls” and 
serve as a reminder that “we ain’t getting any younger” and at times like those we realize so many of the things that 
sometimes bother us really aren’t important at all and at the same time we take so many truly important things in our 
lives for granted. One of my business partners told me something years ago that I try to remember:  “Don’t sweat the 
small stuff……and it’s ALL small stuff”. 
 
If you haven’t come up with a New Year’s resolution yet, or maybe 
already failed at the one you did make, consider adopting this one 
– it seems easier and more doable than going on a diet! 
 
Here’s wishing you and your family a Happy New Year and much 
happiness and success in 2020! 

Mike Remington, Inspec 
MASMS Vendor Rep 
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Make this the year that you send most of your team to  
MASMS Custodial Days! 

Mark your calendar for the MASMS  
 

Custodial/Grounds/ Maintenance days: 
 

Metro Area:  June 17 or 18, 2020 
Hastings, Minnesota 

 

North/NW/West Area:  June 23, 2020 
Hill City, Minnesota 

 

Southern Area:  June 25, 2020 
Mankato, Minnesota 

Generations of Communication 
The faces of tomorrow’s leaders is changing.  19-35 

years of age are now the single largest generation in 

America.  The way they communicate and process  

information is different than any other generation.   

 

Important Points 

• In 2020 1/3 of all adults will be millennials. 

• Most will not measure success in terms of money, 

but by their ability to accomplish goals and make a 

difference. 

• They will hail from a wide age and cultural range. 

• Virtually they will have all grown up in an online 

and connected world, which means attention spans 

are shrinking and they tune out messages they do 

not connect with. 

• They have grown up in a mobile world, where  

almost everything is available on-demand.   

• They use three to five screens per day (on average) 

- smartphone, tablet, TV, desktop and laptop.   

Connecting 

As a result of growing up in a wireless world, their  

average attention span is eight seconds!  Providing 

clear, concise and engaging messages as part of  

communication will be vital.  Providing professional 

training and development programs and hands-on  

opportunities will be required. 

The purpose of life, 
 after all, is to live it,  

to taste experience  
to the utmost,  

to reach out eagerly  
and without fear for  

newer and  
richer experience! 

...-Eleanor Roosevelt  
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10 Tips and Tricks to Become a  

Master of Microsoft Word 
When it comes to word processing, Microsoft Word is the gold 

standard. More than one billion computer users rely on the  

program every day. That’s nearly one in seven people on the 

entire planet. 

Even though so many consumers use Microsoft Word, not  

everyone knows how to maximize the capabilities of the program. Word is packed with 

a multitude of features that can help make the creation of documents, reports, and text 

files easier. 

Below are 10 of our favorite shortcuts, tips, tricks, and timesavers to supercharge your 

use of Microsoft Word.  

1. Copy, paste, and cut with keyboard shortcuts.  Ask anyone who knows these 

shortcuts — Ctrl + C to copy, Ctrl + V to paste, and Ctrl + X to cut — and they 

will testify to their critical timesaving nature. Master these three basic commands 

and you’ll find yourself zooming through documents  

2. Quickly zoom in or out to save eye strain. Some people like to work in a Word 

window zoomed in to 150%, while others like to eliminate the need to scroll left 

and right or up and down by zooming out to 75% to see a document in its entirety. 

Either way, use the Window > Zoom button to choose the setting that works best 

for you — or look for the “100%” tab with a slider at bottom right of the document 

to easily zoom in or out.  

3. Delete entire words at a time. This is an easy one you may not know about: in-

stead of slowly pecking at the keyboard to delete text, or holding 

down Backspace to eliminate words or entire sentence press Ctrl+Backspace with 

the cursor placed after a word you want to erase a word at a time 

4. Use Smart Lookup to search the Internet. Anytime you highlight a word or 

phrase and right-click it, you’ll see “Smart Lookup,” which serves as a quick 

shortcut to browse the web — without slowing down to open a separate browser 

window.  

5. Remove unwanted formatting. Trying to turn a document from an external source 

into something that works for you? Strange formatting can slow you down, so in-

stead of trying to fix one thing at a time, press Ctrl + Space or click the Clear All 

Formatting button (in newer versions, an eraser on an A on the Home tab) to re-

move formatting from highlighted text and start fresh with your own style.  

6. Tell the program exactly what you want to do. Most newer versions of Word 

include a handy “Tell me what you want to do” field at the top of the toolbar. Insert 

a word or phrase pertaining to any instruction and the program can quickly identify 

the command you’re looking for.  

7. Use multiple clicks to select chunks of copy. Rather than employing the tedious 

drag and highlight method, you can use your mouse to select chunks of copy: dou-

ble-click over a word to highlight it or triple-click to highlight an entire sentence or 

section.   

8. Quickly insert links into a document. Similar to the copy / paste / cut commands, 

learning the keyboard shortcut for adding web links to a document — Ctrl + K — 

will save lots of time  

9. Select the default font you want, not the default font Word wants you to use. 

The best part about Microsoft Word is you can choose the default font — this com-

mand differs by version, but the most reliable way is to click Format > Font, select 

the attributes you want, and then click Default.  

10. Find any word you want quickly and easily. Instead of using your mouse to navi-

gate to the Find command, click Ctrl + F to either open the window in older ver-

sions of Word, or move the cursor automatically to the Search in Document menu 

that always appears in the toolbar in newer versions.  
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MASMS EXECUTIVE BOARD 
PRESIDENT | JIM LEUER, ROCKFORD SCHOOLS 

PRESIDENT  ELECT |   COLIN GREEN, WASECA SCHOOLS 

VICE PRESIDENT | CHRIS WIRZ, ST. FRANCIS SCHOOLS 

PAST PRESIDENT | DON HANSON, OSSEO SCHOOLS 

SECRETARY | KAIN SMITH, FARIBAULT SCHOOLS 

TREASURER | KEVIN HILDEBRANDT, ISG 

VENDOR DIRECTOR | MIKE REMINGTON, INSPEC 

NORTHERN CHAPTER DIRECTOR | OPEN 

SOUTHERN CHAPTER DIRECTOR | KEVIN JOHNSON, RED WING SCHOOLS 

METRO CHAPTER DIRECTOR | CHRIS WIRZ, ST. FRANCIS SCHOOLS 

NW CHAPTER DIRECTOR | REED MCFARLANE, LAKE OF THE WOODS, RETIRED  

WEST CHAPTER DIRECTOR | DOUG SLININGER, ADA-BORUP SCHOOLS 

Employment  Opportunities:  Check it out at www.masms.org   

             New postings weekly. 
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 UPCOMING MASMS EVENTS 
1/14/20   State Meeting 
1/15/20         West Chapter Meeting 
1/16/20         Northern Chapter Meeting 
2/11/20         Metro Chapter Meeting 
2/19/20         Southern Chapter Meeting 
2/20/20         Northern Chapter Meeting 
2/26/20         Northwest Chapter Meeting 
3/10/20         Metro Chapter Meeting 
3/18/20         West Chapter Meeting 
3/19/20         Northern Chapter Meeting 
4/14/20         Metro Chapter Meeting 
4/15/20         Southern Chapter Meeting 
4/16/20         Northern Chapter Meeting 
4/22/20         Northwest Chapter Meeting 
5/6/20           West Chapter Meeting 
5/12/20         State Meeting 
6/17/20         MASMS Metro Custodial Days 
6/18/20         MASMS Metro Custodial Days 
6/23/20         MASMS No/NW/West Custodial Day 
6/25/20         MASMS Southern Custodial Day 
9/30/20         MASMS Fall Scholarship Golf Event 
10/1/20         MASMS Fall Conference 
10/2/20         MASMS Fall Conference 
10/21/20       MASMS Southern Chapter Meeting 
10/28/20       MASMS Northwest Chapter Meeting 
11/10/20       MASMS Metro Chapter Meeting 
11/18/20       MASMS West Chapter Meeting 
11/19/20       MASMS Northern Chapter Meeting 
12/8/20         MASMS Metro Chapter Meeting 

Every person can  
transform the world  

from one of monotony 
and drabness to  
one of excitement  
and adventure. 

-Irving Wallace  


